
1. Software overview

PDF4Teachers is a software dedicated to annotation of learners assessments, in PDF file 
format (or  image  files  of  the  assessments).  It  focuses  on  maximum  productivity  in 
annotating / marking this kind of documents.

PDF4Teachers allows user to quickly add and save recurrent annotations. Edited PDF 
files can then be exported to generate new PDF files including the edits. When using the 
grades / marking tool, setting up a marking scale, summing points, and exporting marks 
of all documents to a CSV spreadsheet is made extremely efficient. A skills evaluation 
tool  allows  to  create  different  assessments,  and then to  pair  each  document  to  an 
assessment. Skills levels can be imported / exported from / to the SACoche tool.

PDF4Teachers concept is to add elements on the document before exporting it, as a new 
PDF file. Elements can be text annotations, LaTeX or LibreOffice Math formulas, marks, 
SVG drawings and images. Elements are saved in distinct files, each edited PDF file has 
an associated edit set of informations (see 2. Edit functions)

A set of image files can be converted in PDF documents, and pages format can be edited 
(rotation,  position,  add  pages…)  through  the  edit  pages  mode  or  through  buttons 
located on the top right corner of each page, or using the edit pages mode. It is also 
possible to take screenshots of pages with a configurable definition, possibly higher than 
the screen one.

PDF4Teachers conforms to EU GDPR (General Data Protection Regulation): edits and PDF files 
are locally stored. Web accesses purposes are only: check for updates, new interface 
languages download and anonymized statistics.

Anonymized statistics only include:
• total time spent with PDF4Teachers main window in foreground,
• number of times application was launched,
• selected language.
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2. Edit functions

2. Edit functions

Various elements can be added on the document 
(text,  grades / marks).  These elements constitute 
the  edit  of  the  document  which  is  stored 
separately.

(See Tools → Debug → Open the data folder).

Left side figure shows texts elements and grades. 
Elements  can  be  moved,  and  edited  in  the  left 
panel tabs of PDF4Teachers.

Document edit is loaded as an overlay every time the document is opened in the main panel, 
but the PDF file is not modified (except when rotating, adding, removing and moving pages).

Once editing is finished, document should be exported, in order to create a new PDF file, on 
which the whole edit will be permanently added (File → Export).

It is possible to export/import one/some edits with Tools → Export/Import edits.

3. Files Tab

Left panel is composed of 4 tabs. First tab (showed on the 
left side figure) lists all the opened documents, ready to 
be edited.

This tab is just a list of files that you decided to add to this 
set (File → Open […]).

It allows a quick access to a set of files and shows details 
about the files edits.

It is possible to edit files (double click) or do other actions (right click).

Drag and drop some files, folders or pictures on this tab is also possible.
File sorting in the tab can be set through the 4 top buttons of the tab.
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4. Text elements tab

4. Text elements tab

Creating a new text element is done by a click on new. Text is written in the form field of 
the tab. The element displays on the left side of the sheet.

The height of the insertion point is determined by the last flyover of the mouse pointer 
when leaving the sheet to the left panel. Anticipating this behavior will help you placing 
immediately the element at the correct height on the page.

It is also possible to add a new text element with a double-click on the page or with  
shortcut   +  .  In this case, the element is inserted  at the exact location of the 
pointer. A double click, after selecting an element, duplicates it.

When typing an element in  the text  field,  similar  elements  are highlighted.  You can 
navigate among them with the keyboard arrows, and add one with .

Categories  “Favorite  elements”,  “Previous  elements”,  “Current  document  elements” 
allow a quick access  to already inserted text  elements.  Elements  can be dragged & 
dropped on the sheet, or inserted with a left click. A right click on a listed element, on a  
category, or on an element inserted on the page, gives access to the contextual menu, 
with various shortcut functionalities.

The maximum width of a text element can be defined with it’s right border. This border 
become red when the element text has been wrapped due to the maximum width.

The default maximum width can be defined in the settings.
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4. Text elements tab

Saving elements lists

Icon  allows to save the content of the favorites list. Thus, favorites can be organized 
and loaded for future corrections of similar assessments.

Icon   gives  access  to  previously  saved  favorites  elements.  Loading  or  deleting  is 
possible. After loading, modifications in the panel list will not affect the saved list. To 
modify a saved list, a new one must be created, with the same name.

Details about the different elements lists

Favorite Elements  :   Adding to Favorite Elements is done through the context menu on 
elements present in others lists or in the page. When done from a list, default behavior 
will move the element from the list to the Favorite Elements list. In order to have a copy  
behavior, a setting can be done in the Settings menu.

Previous Elements  :   Each new element is added in the Previous Elements list. This list 
stores a limited number of elements (see settings). List can be flushed through context 
menu, on the category. When an element shows up in Previous Elements, it is linked to 
the page element that was just created. The link symbol   means that any further 
modification of the specific element on the sheet will update the element in the list. It 
can be unlinked through the context menu. It is possible to add and link an element by 
pressing  when adding it.

It is possible to add an element from a list replacing the currently selected element by 
pressing  (or ).

The elements lists,  the favorites elements and previous elements are saved in a file 
named which can be found with Tools  → Debug →  Open the data 
folder.

Writing math formulas (LaTeX or LibreOffice Math)

LaTeX elements can be inserted by starting the text element with  or by enclosing 
the LaTeX formula with  . Likewise, you can write in LibreOffice Math language, by 
enclosing the formula with 

 for π or other maths characters & symbols

 

 

 “The vector  is vertical”
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5. Marking Tab

5. Marking Tab

The buttons on top of the tab have info-bubbles 
detailing their use when leaving the pointer device 
on it.

This  Tab  potentially  allows  the  user  to  enter  a 
grade scale (marking scheme) while correcting the 
first document of a set. Same tool allows to enter 
marks. Marking scale can then be copied on other 
documents  thanks  to  the  button  .  Of  course 
only  the  scale  will  be  copied,  not  the  marks 
possibly entered. In case a marking scale already 
exists in the destination files, merging options will 
be displayed.

At anytime, all the marks of a set of documents (or 
of  a  single  document)  can  be  exported  to  a 
spreadsheet file in .csv type with the button .

Marks and marking scale are managed through a hierarchical scheme. This allows to 
automatically add marks of an exercise to show the exercise sum, and to automatically 
add the marks of each exercise to a total. A maximum of 4 levels + total is possible. 
Display options are set with .

Add of a new mark in the marking scale is done with the   button which will add a 
mark of a lower hierarchical level: on the above figure, a click on the  button right to 
the  Ex1 mark would create a sub-mark  after the c mark, with same hierarchical level, 
and automatically named d.

Unentered marks are not visible on the sheet, they will show up at the last position of 
the pointing device, once enstered. Unentered marks count for 0 in the sum.

When copying a marking scale, it it possible to store the page locations of the marks. In 
this  case,  all  the marks  will  be visible  on the others  documents.  This  option  avoids 
positioning again  and again the marks  on each document (when the students  reply 
directly on the same formatted subject of questions). Marks without value will not be 
visible on exported PDF, even though they are visible when editing.

It is possible to give the name "Bonus<...>" to a mark, so its marking scale value will not 
be added to the total of the marking scale (but the Bonus mark will be summed).
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6. Skills acquisitions tab

6. Skills acquisitions tab

Unlike  the  numerical  marking,  the  skills 
marking  is  organized  by  assessment.  A  new 
assessment  must  be  created  with  the  
button.  Skills  can  then  be  added  to  the 
assessment in the first tab, and the marking 
mode is handled in the second one.

Once  the  assessment  is  configured,  each 
document  can  be  associated  to  the 
assessment, thanks to the drop down menu at 
the top of the tab.

It is then possible to pick an acquisition level for each skill listed in the tab (drop down 
menu or associated key). To reset an acquisition level, hit   or use the contextual 
menu.

A skills table element will show up on the document, it can be moved and resized.  It 
will be by default displayed on the exported document.

Assessment configuration can be imported from the SACoche skills acquisition follow-
up  tool.  In  this  case,  “Ajout  d’informations  sur  les  codes  de  notation  pour 
PDF4Teachers” should be checked, in order to get the SACoche informations about the 
different skill marking modes.

Each  document  can  then  be  paired  to  a  SACoche  student,  in  order  to  export  the 
acquisitions levels to a CSV spreadsheet, which will then be re-imported into SACoche.

Standard CSV export may also be achieved by using the buttons at the bottom of the 
assessment settings window ( ).
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7. Images and vector elements tab

7. Images and vector elements tab

Just like any text element, images and vector elements can 
be added to favorites, and are handled through lists.

• A simple click on an image or a vector drawing from a 
list  activates its  placement on the sheet.  It  is  then 
placed on the page with another click and a drag to 
fix its size.

• A  double  click  places  directly  the  element  on  the 
page, like the single click does it  for text elements 
(default size, height on page determined by the last 
flyover of the pointer)

• The element can also be dragged & dropped to the 
sheet.  It  is  faster,  but  the  immediate  resize  is  not 
available.

The button   allows to replace the selected element by 
another file, or do actions on the element.

Images

Images can be added to PDF4Teachers thanks to the gallery window (Button , or 
menu  ). Folders are added to the gallery by using its drop down menu on the right:

It is also possible to add images to the edit, bypassing the gallery with the menu  .
Images are not stored in the edit, PDF4Teachers links it to the image file on the source 
folder. May the image be deleted or moved, PDF4Teachers would not be able to display 
it anymore.

Vector elements

Vector elements enable to add customized shapes, which can also be freeform  lines. 
These are encoded as a Scalable Vector Graphics (SVG) path.
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7. Images and vector elements tab

Basic commands to draw SVG are   to move on the drawing (pen up), and 
 to draw a segment from current position to a point of coordinates (x, y). A 

series of  commands forms a curve. Hence, a vector element can be a series of 
curves.

A new element can either be created with the menu , or by using   +  , which 
will directly launch the drawing mode.

Each vector element can only be made of a single filling color (disabled with ) and of 
a single line color (line width is set with  ).

Vector figures: vector elements drawing mode 

The drawing mode of a vector element allows to draw with a mouse, a trackpad, or a 
drawing tablet, on the whole page extent. It can be activated/deactivated with  , or 
with a double click, or  on a selected vector element.

Figures panel options allow to draw straight line or forced horizontal/vertical lines. One 
can  draw without clicking, by simultaneously pressing  ; this special feature is 
particularly useful when drawing on a trackpad.

The drawing mode leaves access to the other features of PDF4Teachers: one can still 
access to pages context menu, or add a text element with a double click.  However, 
creating an other kind of element will end the drawing mode.

While annotating mainly with freeform lines, it is strongly recommended to enable the 
element automatic splitting in the settings for not having a unique large element on 
each page.
Button  or  key deletes only the last segment of a curve.
In drawing mode,  deletes the last curve of an element.

 +  cancels the last curve of an element.

More information about images and vector elements

When added to favorites or previous elements, the element on the page is linked to the 
one in the list: any further modification of the linked element placed on the document 
will affect the list.

Images inserted from favorites are always linked. But only size an options are concerned: 
changing the source path of a linked image in the document will not affect the list.

In the Drawings tab, the  menu gives:

, which allows to lock proportions, and offers some special modes. With 
,  these settings are  mainly  meant  for  special  modifications on default 

vector elements included in the application. , if >0, allows to automatically 
add an arrow to each segment, and set a size.
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Advanced settings

Resize mode
Risizing holds

Arrows lenght



8. Shortcuts

8. Shortcuts

A double click on a page allows to create a new text element at 
the exact position of the pointer.

A right click on the page opens the contextual menu to:
- enter the next mark at the location of the mouse pointer,
- insert one of the mostly used text elements,
- insert one of the mostly used vector elements,
- or one of the mostly used images
On  this  contextual  menu,  a  left  click  on  the  name  of  the 
suggested mark to enter, gives all the points, a right click allows 
to enter them from a list, without the keyboard.

A double click on a mark element sets it to 0.

Other shortcuts:  (Use  instead of  on Mac keyboards)

•   : Creates a new empty text element at the location of the pointer. If  is 
pressed, the new element will not be added to the previous elements list.

•   : Creates a new vector element and launches the drawing mode. If  is 
pressed, the new element will be added or not in the previous elements list, 
depending of the settings.

•   : Selects the next mark field to enter.

•   : Adds a new mark to the marking scale, at the same hierarchical level of 
the selected mark.

•   : Adds the corresponding favorite text element at the pointer position.

•    : Select the matching favorite color for the selected text or vector 
element (    to toggle the filling of vector elements).

•    and    : Change the size or thickness of selected element.

•  : Navigate between text elements tab and vector elements tab.

•   or   : Zoom more (   to zoom less).

•   : Fit Zoom to page width.

•    : Load the next file listed in the files tab.

•    : Load the previous file listed in the files tab.
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